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Measuring surface microgeometry
• Alicona Infinite Focus

• Non-contact
• Optical
• Depth by focus-variation
• Vertical resolution depending on 

choice of magnification
• From x2.5: 2300 nm 
• Down to x100: 10 nm

• Min. measurable roughness:
• Sa: 3.5 down to 0.015

(arithmetic average height)
• Output: xxx.al3d file



Inspecting and correcting the data
• Free tool for analysis of height fields obtained by microscopy

Gwyddion: http://gwyddion.net/
• File→Open... (it opens .al3d files)
• Data inspection: Tools – Read horizontal and/or vertical profiles

Mode: cross / horizontal / vertical (click the image to extract a profile)
• Data correction (outlier removal and adjustment of base):

• Data Process→Correct Data→Mask of Outliers
Data Process→Correct Data→Remove Data Under Mask
Data Process→Mask→Remove Mask

• Data Process→Level→Flatten Base

• Process: Remove outliers, flatten base, remove outliers
• File→Save as... (store processed data as a .gwy file)

http://gwyddion.net/


Profilometry and data export
• Cutout: Use the Crop data tool with Create new image checked
• Roughness measurement along a line:

Use the Calculate roughness parameters tool
• Surface roughness: Use the Statistical quantities tool
• Export using File→Save as...

Choose an image file type (.png, for example)
Remove decorations (Value scale, Lateral scale, frame, etc.)

Note the physical width of the image
and the physical depth that the grayscale
values correspond to. These are available 
from the Statistical Quantities tool.



Height map to mesh by displacement mapping
• We can use Blender for this task https://www.blender.org/
• Following a tutorial https://johnflower.org/tutorial/make-mountains-blender-heightmaps

• Open Blender and delete the default cube (press del and click Delete)
• Add→Mesh→Grid (increase X Subdivisions and Y Subdivisions)
• Import the height map as a texture
• Apply texture to grid as a displacement map
• Set strength to physical depth divided by physical width
• Set shading to smooth (button in panel to the left)
• File→Export→Wavefront (.obj)  [you can uncheck Include UVs]
• This produces xxx.obj and xxx.mtl
• Edit xxx.mtl (set illum 4 and Ni 1.5)
• Ni is the assumed index of refraction

https://www.blender.org/
https://johnflower.org/tutorial/make-mountains-blender-heightmaps


What is a mesh?
• Surface geometry is often modeled by a 

collection of triangles, where some of them 
share edges (a triangle mesh).

• Triangles provide a discrete representation of 
an arbitrary surface. See teapot example.

• The indexed face set is a popular data 
representation of polygon meshes.

• Any polygon mesh can be converted to a 
triangle mesh.

• A .obj file contains indexed face sets.

Figure from Bærentzen et al. Guide to Computational Geometry Processing, Springer, 2012.



What is then a smooth mesh?

• Triangles are flat. Their geometric normals lead to flat shading.
• How do we make the object smooth? Interpolated per-vertex lighting?
• What is the normal in a vertex?

The angle-weighted pseudo-normal is a good choice.

• Another indexed face set is created for the vertex normals.
• Interpolation of the vertex normals across each triangle leads to smooth 

shading.
• The interpolated normal is

called the shading normal.

𝑛𝑛 =
∑𝛼𝛼𝑖𝑖𝑛𝑛𝑖𝑖
∑𝛼𝛼𝑖𝑖𝑛𝑛𝑖𝑖



Linear interpolation across triangles
• A point 𝒙𝒙 in a triangle is given by a weighted average of the triangle vertices

(𝒒𝒒1,𝒒𝒒2,𝒒𝒒3):

• The weights (𝛼𝛼,𝛽𝛽, 𝛾𝛾) are the barycentric coordinates.
• The point is in the triangle if 𝛼𝛼,𝛽𝛽, 𝛾𝛾 ∈ [0; 1]. That is,

• Replace the triangle vertices (𝒒𝒒1,𝒒𝒒2,𝒒𝒒3) by vertex normals and normalize to get 
the interpolated normal.

x 

q1

q2

q3

𝒙𝒙 = 𝛼𝛼𝒒𝒒1 + 𝛽𝛽𝒒𝒒2 + 𝛾𝛾𝒒𝒒3 , 𝛼𝛼 + 𝛽𝛽 + 𝛾𝛾 = 1

𝛼𝛼 ≥ 0 and 𝛽𝛽 ≥ 0 and 𝛼𝛼 + 𝛽𝛽 ≤ 1



Ray-triangle intersection
• Ray: 𝒓𝒓 𝑡𝑡 = 𝒐𝒐 + 𝑡𝑡𝜔𝜔, 𝑡𝑡 ∈ [𝑡𝑡min, 𝑡𝑡max]
• Triangle: 𝒗𝒗0,𝒗𝒗1,𝒗𝒗2
• Edges and geometric normal:

• Barycentric coordinates:

• The ray intersects the triangle’s plane at 𝑡𝑡′ = 𝒗𝒗0−𝒐𝒐 ⋅𝒏𝒏
𝜔𝜔⋅𝒏𝒏

• Find 𝒓𝒓 𝑡𝑡′ − 𝒗𝒗0 and decompose it into portions along the edges 𝒆𝒆0 and 𝒆𝒆1 to get 
𝛽𝛽 and 𝛾𝛾. Then check

v0

v1

v2

r 

o
ω

t
e0

e1

𝒆𝒆0 = 𝒗𝒗1 − 𝒗𝒗0, 𝒆𝒆1 = 𝒗𝒗0 − 𝒗𝒗2,𝒏𝒏 = 𝒆𝒆0 × 𝒆𝒆1

𝒓𝒓 𝛼𝛼,𝛽𝛽, 𝛾𝛾 = 𝛼𝛼𝒗𝒗0 + 𝛽𝛽𝒗𝒗1 + 𝛾𝛾𝒗𝒗2 = 𝒗𝒗0 + 𝛽𝛽𝒆𝒆0 − 𝛾𝛾𝒆𝒆1

𝛼𝛼 ≥ 0 and 𝛽𝛽 ≥ 0 and 𝛼𝛼 + 𝛽𝛽 ≤ 1



Spatial subdivision
• To model arbitrary geometry with triangles, we need many triangles.
• A million triangles and a million pixels are common numbers.
• Testing all triangles for all pixels requires 1012 ray-triangle intersection tests.
• If we do a million tests per millisecond, it still takes more than 15 minutes.
• This is prohibitive. We need to find the relevant triangles.
• Spatial data structures offer logarithmic

complexity instead of linear.
• A million tests become twenty operations

• 15 minutes become 20 milliseconds.

Gargoyle embedded in oct tree [Hughes et al. 2014]

log2 106 ≈ 20



Treelet restructuring bounding volume hierarchy

• Practical GPU-based bounding volume hierarchy (BVH) builder.
1. Build a low-quality BVH (parallel linear BVH).
2. Optimize node topology by parallel treelet restructuring

(keeping leaves and their subtrees intact).
3. Post-process for fast traversal.

Reference:
Karras, T., and Aila, T. Fast parallel construction of high-quality bounding volume hierarchies. In Proceedings of HPG 2013, pp. 89-99. ACM, July 2013.

treelet reorganized
treelet



NVIDIA OptiX https://developer.nvidia.com/optix

• Interactive ray tracing demos: cow (sample 6), glass, PPM, PT, Cook.

Reference:
Parker, S. G., Bigler, J., Dietrich, A., Friedrich, H., Hoberock, J., Luebke, D., McAllister, D., McGuire, M., Morley, K., Robison, A., and Stich, M. OptiX: a 
general purpose ray tracing engine. ACM Transactions on Graphics (SIGGRAPH 2010) 29(4):66, July 2010.

https://developer.nvidia.com/optix
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Two meshes – how to combine?



Multiscale modeling of surface geometry
• Smallest scale: everything is quantum particles. Matter is 

electrons going from place to place (ignore nuclei).
Light-matter interaction: A photon interacts with an electron.

• Microscopic scale: surfaces but no roughness. All details are 
defined.
Light-matter interaction: interaction of electromagnetic waves 
with surfaces.

• Macroscopic scale: objects with a macrosurface and material 
specification (roughness/absorption) mapped onto them.
Light-matter interaction: bidirectional (scattering) distribution 
functions for rays of light.

n

x

ω’
ω

glossy BRDF f (x, , )r ω’ω



Simulation to go from micro to macro
• Take the plane wave solution for Maxwell’s equations.
• The (complex) index of refraction 𝑛𝑛 is a quantity summarizing the microscopic 

material properties (permittivity, permeability, conductivity). 
• Consider an electromagnetic plane wave incident on a surface between two half-

space media (of refractive indices 𝑛𝑛𝑖𝑖 and 𝑛𝑛𝑡𝑡).
• By requiring continuity across the interface, we can derive:

• The law of reflection (direction of reflected light)
• The law of refraction (direction of transmitted light)
• Fresnel’s equations for reflection (amount of reflection vs. transmitted light)

• Neglecting wavelength (assume 𝜆𝜆 → 0), we can trace rays along the direction of 
energy propagation in the waves (along Poynting’s vector).

• Given surface microgeometry, we can use such ray tracing to compute 
bidirectional scattering distribution functions (BSDFs).



Ray tracing specular surfaces
• Fresnel’s equations for reflection (𝑅𝑅 is reflected, 𝑇𝑇 = 1 − 𝑅𝑅 is transmitted)

�̃�𝑟⊥ =
𝑛𝑛𝑖𝑖 cos𝜃𝜃𝑖𝑖 − 𝑛𝑛𝑡𝑡 cos𝜃𝜃𝑡𝑡
𝑛𝑛𝑖𝑖 cos𝜃𝜃𝑖𝑖 + 𝑛𝑛𝑡𝑡 cos𝜃𝜃𝑡𝑡

, �̃�𝑟∥ =
𝑛𝑛𝑡𝑡 cos𝜃𝜃𝑖𝑖 − 𝑛𝑛𝑖𝑖 cos𝜃𝜃𝑡𝑡
𝑛𝑛𝑡𝑡 cos𝜃𝜃𝑖𝑖 + 𝑛𝑛𝑖𝑖 cos𝜃𝜃𝑡𝑡

, 𝑅𝑅 =
1
2

�̃�𝑟⊥ 2 + �̃�𝑟∥
2

• The law of refraction

𝑛𝑛𝑡𝑡 sin𝜃𝜃𝑡𝑡 = 𝑛𝑛𝑖𝑖 sin𝜃𝜃𝑖𝑖 ⇒ cos𝜃𝜃𝑡𝑡 = 1 −
𝑛𝑛𝑖𝑖
𝑛𝑛𝑡𝑡

2

sin2 𝜃𝜃𝑖𝑖

• Directions of reflected and refracted light

𝜔𝜔𝑠𝑠 = 2 𝜔𝜔𝑖𝑖 ⋅ 𝑛𝑛 𝑛𝑛 − 𝜔𝜔𝑖𝑖
𝜔𝜔𝑡𝑡 =

𝑛𝑛𝑖𝑖
𝑛𝑛𝑡𝑡

𝜔𝜔𝑖𝑖 ⋅ 𝑛𝑛 𝑛𝑛 − 𝜔𝜔𝑖𝑖 − 𝑛𝑛 cos𝜃𝜃𝑡𝑡



Macro and micro surface

m

• The BSDF defines the ratio of 
light incident in a surface point 𝒙𝒙
from a direction 𝜔𝜔′ that scatters 
into another direction 𝜔𝜔.

• The BRDF 𝑓𝑓𝑟𝑟 is the reflectance 
part of the BSDF.

n

x

ω’
ω

glossy BRDF f (x, , )r ω’ω

The microsurface defines the geometry of 
the differential area d𝐴𝐴 at the position 𝒙𝒙
on the macrosurface.



Bidirectional Reflectance Distribution Function
• The definition of the BRDF: 𝑓𝑓𝑟𝑟 𝒙𝒙,𝜔𝜔𝑖𝑖 ,𝜔𝜔𝑟𝑟 = d𝐿𝐿𝑟𝑟(𝒙𝒙, 𝜔𝜔𝑟𝑟)

d𝐸𝐸(𝒙𝒙, 𝜔𝜔𝑖𝑖)

The ratio of an element of reflected radiance d𝐿𝐿𝑟𝑟 to an element of 
irradiance d𝐸𝐸.

• An element of irradiance due to incident radiance within a differential 
element of solid angle d𝜔𝜔𝑖𝑖:

d𝐸𝐸 𝒙𝒙,𝜔𝜔𝑖𝑖 = 𝐿𝐿𝑖𝑖 𝒙𝒙,𝜔𝜔𝑖𝑖 cos 𝜃𝜃𝑖𝑖 d𝜔𝜔𝑖𝑖

• Radiance is radiant flux per projected area per solid angle:

𝐿𝐿 =
d2Φ

cos𝜃𝜃 d𝐴𝐴 𝑑𝑑𝜔𝜔
, Φ𝑟𝑟 = �

𝐴𝐴
�
Ωr
𝐿𝐿𝑟𝑟 cos 𝜃𝜃𝑟𝑟 d𝜔𝜔r d𝐴𝐴

• Radiant flux Φ is a measurable quantity. So, we can set up a measurement 
equation for reflected radiant flux Φ𝑟𝑟, where 𝐴𝐴 is the microsurface. 

• We can then evaluate a BRDF by solving the measurement equation.

n1

n2

Ωr
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Solid angles

d𝜔𝜔 =
d𝐴𝐴⊥

𝑅𝑅2

Solid angle is area on 
the unit sphere.



BRDF discretization
• For small enough bins 𝐿𝐿𝑟𝑟 ≈

Φ𝑟𝑟 𝐴𝐴, Ω𝑟𝑟
cos Θ𝑟𝑟 𝐴𝐴 Ω𝑟𝑟

, 𝐿𝐿𝑖𝑖 ≈
Φ𝑖𝑖(𝐴𝐴, Ω𝑖𝑖)
cos Θ𝑖𝑖 𝐴𝐴 Ω𝑖𝑖

• Θ𝑥𝑥 is the angle between the macrosurface normal 𝑛𝑛 and the direction Ω𝑥𝑥 in 
the center of the solid angle Ω𝑥𝑥 of the bin.

• Orthographic projection map.
• Map resolution 𝑊𝑊 × 𝐻𝐻

• Solid angle is area on a unit sphere.

• The area of a pixel is then 𝐴𝐴𝑝𝑝 = 4
𝑊𝑊𝑊𝑊

≈ Ω𝑟𝑟 cosΘ𝑟𝑟
T. Tongbuasirilai, J. Unger, J. Kronander, and M. Kurt. Compact and intuitive 
data-driven BRDF models. The Visual Computer, 2019. To appear.

1−1

−1

1

𝐴𝐴∎ = 4

projected unit 
hemisphere

𝐿𝐿𝑖𝑖 𝐿𝐿𝑟𝑟



Reflected radiance equation
• The definition of the BRDF: 𝑓𝑓𝑟𝑟 𝒙𝒙,𝜔𝜔𝑖𝑖 ,𝜔𝜔𝑟𝑟 = d𝐿𝐿𝑟𝑟(𝒙𝒙, 𝜔𝜔𝑟𝑟)

d𝐸𝐸(𝒙𝒙, 𝜔𝜔𝑖𝑖)

• Here 𝒙𝒙 is a location on the macrosurface.
• The reflected radiance is then

𝐿𝐿𝑟𝑟 𝒙𝒙, 𝜔𝜔𝑟𝑟 = �
2𝜋𝜋
𝑓𝑓𝑟𝑟 𝒙𝒙,𝜔𝜔𝑖𝑖 ,𝜔𝜔𝑟𝑟 d𝐸𝐸 𝒙𝒙, 𝜔𝜔𝑖𝑖 = �

2𝜋𝜋
𝑓𝑓𝑟𝑟 𝒙𝒙,𝜔𝜔𝑖𝑖 ,𝜔𝜔𝑟𝑟 𝐿𝐿𝑖𝑖 𝒙𝒙,𝜔𝜔𝑖𝑖 cos 𝜃𝜃𝑖𝑖 d𝜔𝜔𝑖𝑖

• Suppose we consider small solid angle bins, then
𝐿𝐿𝑟𝑟 = 𝑓𝑓𝑟𝑟 𝒙𝒙,Ω𝑖𝑖 ,Ω𝑟𝑟 �

Ω𝑖𝑖
𝐿𝐿𝑖𝑖 𝒙𝒙,𝜔𝜔𝑖𝑖 cos𝜃𝜃𝑖𝑖 d𝜔𝜔𝑖𝑖 = 𝑓𝑓𝑟𝑟 𝒙𝒙,Ω𝑖𝑖 ,Ω𝑟𝑟 𝐸𝐸 𝒙𝒙, Ω𝑖𝑖

• We can use this to set up an expression for evaluating the BRDF

𝑓𝑓𝑟𝑟 𝒙𝒙,Ω𝑖𝑖 ,Ω𝑟𝑟 =
𝐿𝐿𝑟𝑟
𝐸𝐸

=
Φ𝑟𝑟 𝐴𝐴,Ω𝑟𝑟

cosΘ𝑟𝑟 𝐴𝐴 Ω𝑟𝑟 𝐸𝐸(𝒙𝒙,Ω𝑖𝑖)

−𝜔𝜔𝑖𝑖 𝜔𝜔𝑟𝑟



BRDF measurement
• BRDF: 𝑓𝑓𝑟𝑟 𝒙𝒙,Ω𝑖𝑖 ,Ω𝑟𝑟 = Φ𝑟𝑟 𝐴𝐴, Ω𝑟𝑟

cos Θ𝑟𝑟 𝐴𝐴 Ω𝑟𝑟 𝐸𝐸(𝒙𝒙, Ω𝑖𝑖)
• Reflected radiant flux: Φ𝑟𝑟 𝐴𝐴,Ω𝑟𝑟 = ∫𝐴𝐴 ∫Ωr 𝐿𝐿𝑟𝑟 𝒙𝒙𝑚𝑚,𝜔𝜔𝑟𝑟 cos 𝜃𝜃𝑟𝑟 d𝜔𝜔r d𝐴𝐴
• Irradiance: 𝐸𝐸(𝒙𝒙,Ω𝑖𝑖) = ∫Ω𝑖𝑖 𝐿𝐿𝑖𝑖 𝒙𝒙,𝜔𝜔𝑖𝑖 cos 𝜃𝜃𝑖𝑖 d𝜔𝜔𝑖𝑖

• The Fresnel BRDF of the microsurface:
𝑓𝑓𝑚𝑚 𝒙𝒙𝑚𝑚,𝜔𝜔𝑖𝑖 ,𝜔𝜔𝑟𝑟 = 𝑅𝑅 𝑚𝑚,𝜔𝜔𝑖𝑖

𝛿𝛿 𝜔𝜔𝑟𝑟 − 𝜔𝜔𝑠𝑠
cos 𝜃𝜃𝑖𝑖

• The reflected radiance from a point 𝒙𝒙𝑚𝑚 on the microsurface:

𝐿𝐿𝑟𝑟 𝒙𝒙𝑚𝑚,𝜔𝜔𝑟𝑟 = �
2𝜋𝜋
𝑓𝑓𝑚𝑚 𝒙𝒙𝑚𝑚,𝜔𝜔𝑖𝑖 ,𝜔𝜔𝑟𝑟 𝐿𝐿𝑖𝑖 𝒙𝒙𝑚𝑚,𝜔𝜔𝑖𝑖 cos 𝜃𝜃𝑖𝑖 d𝜔𝜔𝑖𝑖

• Then
Φ𝑟𝑟 𝐴𝐴,Ω𝑟𝑟 = �

𝐴𝐴
�
Ωr
�
2𝜋𝜋
𝑅𝑅 𝑚𝑚,𝜔𝜔𝑖𝑖 𝛿𝛿 𝜔𝜔𝑟𝑟 − 𝜔𝜔𝑠𝑠 𝐿𝐿𝑖𝑖 𝒙𝒙𝑚𝑚,𝜔𝜔𝑖𝑖 d𝜔𝜔𝑖𝑖 cos 𝜃𝜃𝑟𝑟 d𝜔𝜔r d𝐴𝐴



Evaluating difficult integrals

• This measurement equation is difficult (if not impossible) to solve analytically.
• Trapezoidal integration and Gaussian quadrature only works well for smooth low-

dimensional integrals.
• This integral is 6-dimensional, recursive, and could involve discontinuities.
• Three known mathematical methods for solving this type of problem:

• Truncated series expansion
• Finite basis (discretization)
• Sampling (random selection)

• Monte Carlo integration is probably the simplest way to use sampling.

Φ𝑟𝑟 𝐴𝐴,Ω𝑟𝑟 = �
𝐴𝐴
�
Ωr
�
2𝜋𝜋
𝑅𝑅 𝑚𝑚,𝜔𝜔𝑖𝑖 𝛿𝛿 𝜔𝜔𝑟𝑟 − 𝜔𝜔𝑠𝑠 𝐿𝐿𝑖𝑖 𝒙𝒙𝑚𝑚,𝜔𝜔𝑖𝑖 d𝜔𝜔𝑖𝑖 cos 𝜃𝜃𝑟𝑟 d𝜔𝜔r d𝐴𝐴



Monte Carlo integration
• The law of large numbers

Pr
1
𝑁𝑁
�
𝑖𝑖=1

𝑁𝑁

𝑓𝑓(𝑋𝑋𝑖𝑖) → 𝐸𝐸 𝑓𝑓(𝑋𝑋) = 1 for 𝑁𝑁 → ∞

”it is certain that the estimator goes to the expected value as the number of samples goes to infinity”

• Approximating an arbitrary integral by stochastic sampling:

𝐹𝐹 = �
𝐴𝐴
𝑓𝑓 𝑥𝑥 d𝑥𝑥 = �

𝐴𝐴

𝑓𝑓 𝑥𝑥
pdf 𝑥𝑥

pdf 𝑥𝑥 d𝑥𝑥 = 𝐸𝐸
𝑓𝑓(𝑥𝑥)

pdf(𝑥𝑥)

• Using the law of large numbers, we have the 𝑁𝑁th estimator

𝐹𝐹𝑁𝑁 =
1
𝑁𝑁
�
𝑖𝑖=1

𝑁𝑁
𝑓𝑓(𝑋𝑋𝑖𝑖)

pdf(𝑋𝑋𝑖𝑖)

where 𝑋𝑋𝑖𝑖 sampled on 𝐴𝐴 and pdf 𝑥𝑥 > 0 for all 𝑥𝑥 ∈ 𝐴𝐴.



Monte Carlo estimator
• Let us consider one (sampled) direction of incidence 𝜔𝜔ℓ ∈ Ω𝑖𝑖:

𝐿𝐿𝑖𝑖 𝒙𝒙,𝜔𝜔𝑖𝑖 = 𝛿𝛿 𝜔𝜔𝑖𝑖 − 𝜔𝜔ℓ 𝐿𝐿𝑒𝑒

𝐸𝐸 𝒙𝒙,Ω𝑖𝑖 = �
Ω𝑖𝑖
𝐿𝐿𝑖𝑖 𝒙𝒙,𝜔𝜔𝑖𝑖 cos 𝜃𝜃𝑖𝑖 d𝜔𝜔𝑖𝑖 = 𝜔𝜔ℓ ⋅ 𝑛𝑛 𝐿𝐿𝑒𝑒 = 𝐿𝐿𝑒𝑒 cos 𝜃𝜃ℓ

• Emitted radiance 𝐿𝐿𝑒𝑒 is considered constant across the microsurface.
• Because of the directional 𝛿𝛿-functions (deterministic light paths), we need now 

only sample the microsurface area 𝐴𝐴.
• The Monte Carlo estimator then becomes

𝑓𝑓𝑟𝑟 𝒙𝒙,𝜔𝜔ℓ,Ω𝑟𝑟 =
1
𝑁𝑁
�
𝑗𝑗=1

𝑁𝑁
𝑅𝑅 𝑚𝑚,𝜔𝜔𝑖𝑖 𝐿𝐿𝑖𝑖 𝒙𝒙𝑗𝑗 ,𝜔𝜔𝑖𝑖 cos 𝜃𝜃𝑟𝑟

cosΘ𝑟𝑟 𝐴𝐴 Ω𝑟𝑟 𝐿𝐿𝑒𝑒 cos 𝜃𝜃ℓ pdf(𝒙𝒙j)
𝜔𝜔𝑠𝑠 ∈ Ω𝑟𝑟

• ∗ is an Iverson bracket, which is 1 if ∗ is true, 0 otherwise.



Computing a BRDF from microgeometry
• One randomly placed sample per pixel (jitter sampling):

𝑁𝑁 = 𝑊𝑊𝐻𝐻, pdf 𝒙𝒙j =
1
𝐴𝐴 , Ω𝑟𝑟 cosΘ𝑟𝑟 ≈

4
𝑊𝑊𝐻𝐻

• Since the constant emitted radiance cancels out, we set 𝐿𝐿𝑒𝑒 = 1.
• Suppose we always choose either reflection or transmission:

• Russian roulette with 𝑅𝑅 𝑚𝑚,𝜔𝜔𝑖𝑖 as the probability of reflection.

• The Monte Carlo estimator is then

𝑓𝑓𝑟𝑟 𝒙𝒙,𝜔𝜔ℓ,Ω𝑟𝑟 =
1

4(𝜔𝜔ℓ ⋅ 𝑛𝑛)
�
𝑗𝑗=1

𝑁𝑁

𝐿𝐿𝑖𝑖 𝒙𝒙𝑗𝑗 ,𝜔𝜔𝑖𝑖 (𝜔𝜔𝑠𝑠⋅ 𝑚𝑚) 𝜉𝜉 < 𝑅𝑅 𝑚𝑚,𝜔𝜔𝑖𝑖 ∧ 𝜔𝜔𝑠𝑠 ∈ Ω𝑟𝑟

• 𝜉𝜉 ∈ 0,1 is a continuous, uniform, random variable.
• We compute 𝐿𝐿𝑖𝑖 𝒙𝒙𝑗𝑗 ,𝜔𝜔𝑖𝑖 by path tracing the microsurface.

−1 1𝒙𝒙𝑗𝑗

−𝜔𝜔ℓ

𝒐𝒐 𝑛𝑛 = (0,0,1)

𝑚𝑚 𝜔𝜔𝑠𝑠

Ω𝑟𝑟

𝜔𝜔𝑠𝑠

pixel



Progressive unidirectional path tracing
1. Generate rays from the camera through pixel positions.
2. Trace the rays and evaluate the rendering equation for

each ray.
3. Randomize the position within the pixel area to Monte

Carlo integrate (measure) the radiance arriving in a pixel.

• Noise is reduced by progressive updates of the measurement.
• Update the rendering result in a pixel 𝐿𝐿𝑗𝑗 after rendering a new

frame with result 𝐿𝐿new using
𝐿𝐿𝑗𝑗+1 =

𝐿𝐿new + 𝑗𝑗𝐿𝐿𝑗𝑗
𝑗𝑗 + 1

• Progressive (stop and go) rendering is convenient for several reasons:
• No need to start over.
• Result can be stored and renfined later if need be.
• Convergence can be inspected during progressive updates.

p0

p1

p2

p3

http://www.pbr-book.org/

http://www.pbr-book.org/


Timeline on the programmability of the GPU

1995 Fixed-function rasterization pipeline in hardware.
2001 Vertex shaders (rst programmable part of the pipeline).
2003 Fragment/pixel shaders (GPGPU).
2006 Unied shaders (CUDA) and geometry shaders.
2008 Double precision arithmetics.
2009 Compute shaders (interoperability) and tesselation shaders.
2010 Streaming multiprocessor architecture. Programmable ray tracing pipeline on the GPU.
2012 Dynamic parallelism (threads spawn threads).
2016 Unied memory (on demand data migration and dynamic memory allocation).
2018 Hybrid rendering (CUDA cores, RT cores, DNN tensor cores).
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GPU ray tracing (OptiX)

• Sample surface positions in the “Ray Generation” program and do 
progressive updates.

• Return ray direction from the “Miss” program
• Implement shader for specular surfaces in the “Closest Hit” program.



Ray direction as the result (miss program)

• Set up the scene so that the microsurface 
mesh covers the square observed by the 
orthographic camera −1,1 × −1,1 .

• Trace light rays toward observed points.
• Return the final ray direction of each path.
• Use the directions to estimate the BRDF.

// Standard ray variables
rtDeclareVariable(Ray, ray, rtCurrentRay, );
rtDeclareVariable(PerRayData_radiance, prd, rtPayload, );

RT_PROGRAM void miss()
{

prd.result = ray.direction;
}

// Payload for radiance ray type
struct PerRayData_radiance
{

optix::float3 result;
int depth;
unsigned int seed;
optix::float3 hit_normal;

};

Direction of reflected ray in sampled positions.



RT_PROGRAM void pinhole_camera()
{

PerRayData_radiance prd;
prd.depth = 0;
prd.seed = tea<16>(launch_dim.x*launch_index.y + launch_index.x, frame);
prd.result = prd.hit_normal = make_float3(0.0f);

float2 jitter = make_float2(rnd(prd.seed), rnd(prd.seed));
float2 ip_coords = 2.0f*jitter - 1.0f;
Directional& light = lights[0];
float3 origin = make_float3(ip_coords.x, ip_coords.y, 0.0f) - 10.0f*light.direction;
Ray ray(origin, light.direction, radiance_ray_type, scene_epsilon, RT_DEFAULT_MAX);
rtTrace(top_object, ray, prd);

if(prd.result.z > 0.0f) {
uint2 new_idx = make_uint2(make_float2(launch_dim)*(0.5f + make_float2(prd.result.x, prd.result.y)*0.5f));
output_buffer[new_idx] += make_float4(0.25f/(-light.direction.z)*dot(prd.result, prd.hit_normal));

}
}

Orthographic projection (camera program)
image plane (ip)
jitter sampling

−1 1𝒙𝒙𝑗𝑗

−𝜔𝜔ℓ

𝒐𝒐 𝑛𝑛 = (0,0,1)

𝑚𝑚 𝜔𝜔𝑠𝑠

Ω𝑟𝑟

𝜔𝜔𝑠𝑠



Specular material shader (closest hit program)
RT_PROGRAM void transparent_shader()
{

if(prd.depth++ > max_depth) return;
float3 hit_pos = ray.origin + t_hit*ray.direction;
float3 normal = normalize(rtTransformNormal(RT_OBJECT_TO_WORLD, shading_normal));
float n1_over_n2 = 1.0f/ior;
float cos_theta_i = dot(-ray.direction, normal);
if(cos_theta_i < 0.0f) { n1_over_n2 = ior; normal = -normal; cos_theta_i = -cos_theta_i; }
prd.hit_normal = normal;

float R = 1.0f;  // Compute Fresnel reflectance
float sin_theta_t_sqr = n1_over_n2*n1_over_n2*(1.0f - cos_theta_i *cos_theta_i);
float cos_theta_t = 0;
if(sin_theta_t_sqr < 1.0f) {

cos_theta_t = sqrtf(1.0f - sin_theta_t_sqr);
R = fresnel_R(cos_theta_i, cos_theta_t, n1_over_n2);

}
float3 dir;        // Russian roulette to choose reflection or refraction
if(rnd(prd.seed) < R) dir = reflect(ray.direction, normal);
else dir = n1_over_n2*ray.direction + normal*(n1_over_n2*cos_theta_i - cos_theta_t);
Ray new_ray(hit_pos, dir, radiance_ray_type, scene_epsilon, RT_DEFAULT_MAX);
rtTrace(top_object, new_ray, prd);

}



Progressive updates (second camera program)
rtBuffer<float4, 2> output_buffer;
rtBuffer<float4, 2> p_output_buffer;
rtDeclareVariable(uint2, launch_index, rtLaunchIndex, );
rtDeclareVariable(uint, frame, , );

RT_PROGRAM void progression_camera()
{

float4 c = output_buffer[launch_index];
float4 curr_sum = (frame != 0) ? p_output_buffer[launch_index] * ((float)frame) : make_float4(0.0f);
p_output_buffer[launch_index] = (c + curr_sum) / ((float)(frame + 1));
output_buffer[launch_index] = make_float4(0.0f);

}



Agenda

• Introduction
• Tools and measurements
• Multiscale modeling
• Computing the BRDF using Monte Carlo simulation
• Procedural modeling of surface microgeometry
• Applying microgeometry to surfaces in 3D printing



Noise
• Noise explorer: 

https://people.compute.dtu.dk/jerf/code/noise/

• Sparse convolution noise
• Convolution of randomly placed (𝒙𝒙𝑖𝑖,𝑗𝑗) 

impulses of random value (𝛼𝛼𝑖𝑖,𝑗𝑗).
• Use a filter kernel with compact support 

and insert a regular grid (cell vertices 𝒒𝒒𝑖𝑖).

cubic 𝒗𝒗 = � 1 − 4 𝒗𝒗 ⋅ 𝒗𝒗 3 for 𝑣𝑣 ⋅ 𝑣𝑣 <
1
4

0 otherwise
• Use a seeded RNG: rnd(𝑡𝑡)
• Choose a number of impulses per cell (𝑁𝑁).

noise 𝒑𝒑 =
4

53 𝑁𝑁
�
𝑖𝑖=0

7

�
𝑗𝑗=1

𝑁𝑁

𝛼𝛼𝑖𝑖,𝑗𝑗 cubic(𝒙𝒙𝑖𝑖,𝑗𝑗 − 𝒑𝒑)

𝒙𝒙𝑖𝑖,𝑗𝑗 = 𝒒𝒒𝑖𝑖 + 𝝃𝝃𝑖𝑖,𝑗𝑗
𝛼𝛼𝑖𝑖,𝑗𝑗 = rnd 𝑡𝑡𝑛𝑛𝑖𝑖,𝑗𝑗 1 − 2 𝑗𝑗 mod 2

𝝃𝝃𝑖𝑖,𝑗𝑗 = rnd 𝑡𝑡𝑛𝑛𝑖𝑖,𝑗𝑗+1 , rnd 𝑡𝑡𝑛𝑛𝑖𝑖,𝑗𝑗+2 , rnd 𝑡𝑡𝑛𝑛𝑖𝑖,𝑗𝑗+3
𝑛𝑛𝑖𝑖,𝑗𝑗 = 4 𝑁𝑁𝒒𝒒𝑖𝑖 ⋅ 𝒂𝒂 + 𝑗𝑗

𝒒𝒒𝑖𝑖 = 𝒑𝒑 −
1
2 ,

1
2 ,

1
2 + 𝑖𝑖 mod 2,

𝑖𝑖
2 mod 2,

𝑖𝑖
4 mod 2

My choice: 𝑁𝑁 = 30 and 𝒂𝒂 = (1, 1000, 576)

0.5 𝐴𝐴 noise 𝐵𝐵 𝒑𝒑 + 1
𝐴𝐴 = 1,𝐵𝐵 = 1

https://people.compute.dtu.dk/jerf/code/noise/


Noise-based modeling
• Noise with octaves

• Number of octaves Ω ≥ 1
• Lacunarity ℓ > 1
• Fractional increment (roughness) 𝐻𝐻 ∈ 0,1

fBm 𝒑𝒑 = �
𝑖𝑖=0

Ω−1

ℓ−𝑊𝑊𝑖𝑖noise(𝒑𝒑 ℓ𝑖𝑖)

• 𝐻𝐻 = 1 is a monofractal
(same fractal dimension everywhere)

• Absolute value for sharp edges

turbulence 𝒑𝒑 = �
𝑖𝑖=Ωlow

Ωhigh
1
2𝑖𝑖

noise(2𝑖𝑖 𝒑𝒑)

Top rows: input from marble images

Kim Harder Fog. Noise-based texture synthesis by analysis of image examples.
MSc thesis, Technical University of Denmark, 2017.

Bottom rows: fBm fit



Line integral convolution
• Given a 3D noise function like sparse convolution noise:

• For each pixel take the integral along a line.

• Obtain a tangent space of
your 3D surface to be printed.
https://people.compute.dtu.dk/jerf/code/hairy/

+

References:
- Battke, H., Stalling, D., Hege H.-C. Fast line integral convolution for arbitrary surfaces in 3D. In Visualization and Mathematics, pp. 181-195. Springer, 1997.
- Frisvad, J. R. Building an orthonormal basis from a 3d unit vector without normalization. Journal of Graphics Tools 16(3):151-159, August 2012.

https://people.compute.dtu.dk/jerf/code/hairy/
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Intro on 3D printing
Types of 3D Printers

•Material Extrusion: fused deposition
modelling (FDM), direct writing assembly
(DWA), . . . ;
• Powder: binder jetting, selective laser
sintering, . . . ;
• Lamination: laminated object
manufacturing (LOM), selective
deposition lamination (SDL), . . . ;
• Photopolymerization: stereolitography
(SLA), digital light processing (DLP), . . . ;
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Intro on 3D printing
What is a DLP?

Elements of a DLP printer:
• Photopolymer;
• Vat;
• Building Platform (Step
precision: 1µm);
• DLP Projector (2560× 1600
micro-mirrors, pixel pitch of
7.54µm)
•Membrane (optional)

Membrane

Projector

Vat

Buildplate

Resin

Glass
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Effect of grayscale
Effect of Grayscale (Autodesk [Greene 2016])

• subvoxel resolution;
• subvoxel offset;
• antialiasing;

• random noise to remove
moiré patterns;

5 Technical University of Denmark 11.9.2018



How to use grayscale
Control Voxel Growth

Relationship between curing process and uv
intensity is not linear:

τf(I) =
{
α+ β log(I − γ) , for I > e−α/β + γ ,

0 , for I ≤ e−α/β + γ ,

If we know α, β, and γ we can correct
before projection:

f−1(I) =
{

e
τ I−α
β + γ , for I > 0 ,

0 , for I = 0 ,

6 Technical University of Denmark 11.9.2018



Experiments
Parameters Calibration

We need to calibrate the projector inten-
sity and the exposure time:
• fix exposure time;
• print calibration sample with
increasing intensity;
• fix intensity;
• print calibration sample with
increasing exposure tim;

Layer thickness: 18µm;
UV LED amplitude: 230;
Exposure time: 3s;

8 Technical University of Denmark 11.9.2018



Experiments
Voxel Height Measurements

We need to estimate c, β, and γ to ob-
tain linearity:
• print linear pattern with all gray
values;
• measure the surface height with a
resolution of 0.4µm;
• find a fit and estimate the
parameters;

α = 17.71 µm
β = 10.24 µm
γ = −0.01

9 Technical University of Denmark 11.9.2018



How to use grayscale
Applying Grayscale
• Supersampling during slicing to apply AA

(rasterization/ray tracing);

Patterns to control the microstructure and
roughness of the surface:
• 2D sinusoid

I(u, v) = 1
2 sin

(
2π
λu
u

)
sin
(

2π
λv
v

)
+ 1

2;

• Solid sparse convolution noise

noise(p) = 4
5 3
√
N

7∑
i=0

N∑
j=1

αi,j cubic(xi,j−p)

I(p) = A

2 (noise(B p) + 1)

• Ridged structure and 2D sinusoid to control
anisotropy;
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How to use grayscale
Applying Grayscale
• Supersampling during slicing to apply AA

(rasterization/ray tracing);
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• 2D sinusoid
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• Solid sparse convolution noise

noise(p) = 4
5 3
√
N

7∑
i=0

N∑
j=1

αi,j cubic(xi,j−p)

A
I(p) = 2 

noise(B p) + 1/2

• Ridged structure and 2D sinusoid to control
anisotropy;
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How to use grayscale
Applying Grayscale
• Supersampling during slicing to apply AA
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Results
Results V

14 Technical University of Denmark 11.9.2018



BRDF printing and 3D printer ground noise

ground 𝒑𝒑 =
2
3 noise

𝒑𝒑
50 𝜇𝜇𝑚𝑚 +

1
9 noise

𝒑𝒑
25 𝜇𝜇𝑚𝑚 +

1
12 noise

𝒑𝒑
2 𝜇𝜇𝑚𝑚



Anisotropic smileys (ridges and sinusoids)

Top row: 3D printed
Middle row: computed
Bottom row: direction of incidenceInput texture and microscope images.



Thank you for your attention

A. Luongo, V. Falster, M. B. Doest, M. M. Ribo, E. R. Eiriksson, D. B. Pedersen, and J. R. Frisvad. Microstructure
control in 3D printing with digital light processing. Computer Graphics Forum, 2019. To appear.

The slides on dark gray background are courtesy of Andrea Luongo.
Thanks to all co-authors of the work mentioned below.
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